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Before you start...

What you should already know

We assume that you are familiar with the Windows® and Mac 0S X° operating systems that are sup-
ported by this application.

A basic Signa Station Training is required to understand this documentation!

Additional Documentation

You can find this document and additional information in:

« Educate Center: http://educate-center.heidelberg.com/ilias/
login.php?target=crs_1517&soap_pw=&ext_uid=&cookies=nocookies&client id=HEIl-e-
Learning&lang=en

« Easy Sales Portal: https://hdmnet.sharepoint.com/sites/EasySales/Pages/
Search.aspx#tk=ProductArea%3APrinectf#(=1033

« Online Help: http://onlinehelp.prinect-lounge.com/Prinect Signa Station/Version2020/en/
Ht=Prinect%?2FTitle RoboHelp%?2FTitle RoboHelp.htm

Important Information

Important information in the text is marked by symbols that are used as follows:

Warning: Contains information that must be taken into consideration to protect the user
from injury.

Attention: Contains information that must be taken into consideration to prevent damage
to hardware or software.

Note: Contains important general or supplementary information about a specific topic.

Note: This feature was implemented in Signa Station 2020.10.
2020.10

HED>
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1 General

1 General

. Note: This features were implemented in Signa Station 2020.10.
2020.10

1.1 Password Protection for Preferences

Motivation

Changing the Signa Station preferences can disable automated workflows with Signa Server or Signa
Gang Server. For this reason we should protect the preferences.

Description

In 'File > Preferences > General' we can now enable a password protection.

Import Processes Output Licensing Ganging Optimization User Interface Packaging
Paths Names Defaults Resources Marks Reports JDF Import

Tooltips

Default unit of measure:
nbly Block
MNumber of Recent Jobs: |10
Language
Language:

Color Scheme Preferences

Shortc
O us and Key + Spacebar for Zoom

Suppressed Messages:
Number Text Button
51068 : Afolding sheetin sheet” ’lies on the gripper margin! Do you want to print neverthe ? Cancel

21019 : 2rnal ma ckl Mo

Remove Selected Remaove All 7

Close
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1 General

An enabled protection requires the password to open and to edit the preferences.

i8] Prinect Signa Station S

Edit | Jobs&Resources | Inspectors | Tools | Help

Cirl+Q

Solution:

Enter the comrect pass

After this warning the preference dialog is opened, but we cannot save any changes in this condition.

5l Preferences (read only)

Import Processes Output Licensing Ganging Optimization User Interface Packaging
Paths Names Defaults Resources Marks Reports JOF Import
Used Setting
obal Settings (are filed in current works
View Attributes
[ Paper Name Editable Tooltips
Defaultunigof @ 2 o Millimateg

Password for editing the Preferences

Remove Selected Remaove All
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1 General

Only with the correct password we can change the password.

Preferences vord

Shortcut

_ " Please enterthe rd for editing the Prefere
[ use Command Key + Spacebar for Zoom

Password for editing the Preferences

Suppressed Messages:

Note: We can disable a activated password protection in the Preferences.dat file:
Activated = true, deactivated = false

[ E\PTTransfer\Signa\Resources\Resources_20\Preferences.dat - Notepad++ [Administrator]

File Edit Search View Encoding Language Settings Tools Macre Run Plugins Window ? X
cBHERGE shkh e a2 BR2[EH1EERe® IED
|| Preferences.dat | ([>
5030 <ClientName>"com.heidelberg.signa.preferences.PreferenceData"</ClientHams>

5031 <PropertyName>"PreferencePasswordActive"</ProperctyName>

5032 < /0Object>

5033 <Iype>"List"</Type>

5034 <Version>1l</Version>

5035 <Size>l</Size>

5036 <Iype>"Boolean"</Type>

5037 <Object>tme</0bjectq

1.2 Password for Locking and Unlocking Resources

Motivation
Locked Signa Station resources should not be able to unlock by any user.
Description

In 'File >Preferences > Resources' we can now enable a password protection.

Import Processes Output Licensing Ganging Optimization User Interface Packaging
General Paths Names Defaults 1 Marks Reports JOF Import
Set Defaults for New Jobs
efault
@) (T A Resources Password
© Product Part Template:  SignaDefaultTemplat Please enter the password for locking and unlocking resources.
Default for Resources
Reader's Spread Template

1up Proof Template:

Password for locking and unlocking resources

rd:
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1 General

We need a password for locking and unlocking when this feature is enabled.

@& Prinect Signa Station Server - 20.10.20C

File | Edit | Jobs&Resources | Inspectors | Tools

Machines MDS
» 1 Job Templates

»- 1 Product Part Template
1S oo rompltes AV / CD74-6P3L
- \

Rename plate template
[¥ EditPlate Template
e Template
dng resourc
ate Template
ate Template
y Plate Template

1 selin
2 B LockPlate Template -—
{L105-8 ripper]

g Offset: 0.0 mm

Note: We can disable an activated password protection in the Preferences.dat file:
Activated = true, deactivated = false

B E\PTTransfer\Signa\Resources\Resources_20\Preferences.dat - Notepad++ [Administrator]

File Edit Search View Encoding Language Settings Tools Macro Run Plugins Window 7 X
OHE 38 sk oelny x| BE3E [ EEhHaspEn ~
[ Preferences.dat I []>
1944 <Version>1l</Version> A
1945 <ClientName>"com.heidelberg.signa.preferences.PreferenceData"</ClientName>

1946 <PropercyName> "Inenoumrasmtﬂnntiw" </PropertyName>

1947 < /CObject>

<Type>"List"</Type>

1¢ <Version>1</Version>

1950 <5ize>1</Size>

1851 <Type>"Boolean"</T e>

1952 | <0bject.>true</0bject>l
— —
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1 General

1.3 Magnetic Placement of Folding Schemes

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

We have changed the behavior to move folding schemes in the Graphic View to customer needs.
Description

We can move folding schemes and assembly blocks to automatically displayed magnetic help lines -
cyan colored lines.

Montageblock Nutzenliste Druckbogenliste Dokument
M4 »

Joo 75 =] 900 950 1000 1050

oo ool oot latoal o

_I_ oo &50.0 100 150 20 25 =0 250 00 450 S00 S50
wlondo bonlaotaod v ol ool " e vl ol oo e, '

B00 G50
Vool ol i
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1 General

We can move folding schemes and assembly blocks to manually created magnetic help lines - blue
colored lines.

Assembly Block 1up List Press Sheet List Document
! He »

200 400 500 GO0 F00 200 f=Tu ] 1000 14100
vl b O e O L e vl

100 200
vl vl v lvaaa (IR

I
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2 Marks & Text Replacer

2 Marks & Text Replacer

2.1 Multiple Character Formatter for Text Replacer

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation
Until now the formatter for cutting text replacer only allows us to use a one-digit number (0 to 9).

Especially for text replacer that replace too long text, this restriction leads to the fact that the text
cannot be cropped as desired.

Description

With Prinect version 2020.10 onwards, it is now possible to enter any numbers and text in formatters.

Format Visible result In words

$[jobid] 123456Prinect2021654321 No formatting.

$[jobid:13] 123456Prinect Displays the first 13 characters.

$[jobid:-13] ect2021654321 Displays the last 13 characters.

$[jobid:(6,0)] Prinect2021654321 Removes the first 6 and the last O characters.

$ljobid:(1,8)] 23456Prinect20 Removes the first 1 and the last 8 characters.

$[jobid:(Prinect,0)] 2021654321 Remove all first characters including 'Prinect’

$ljobid:(5,Prinect)] |6 Removes the first 5 and the last characters
including 'Prinect’.

$[jobid:(Prin,0)] ect2021654321 Removes the first characters including 'Prin’
and the last O characters.

Using the text replacer "$[jobid]" with the formatter "(6,0)" looks as follows:

| Edit | Jobs&Resources | Inspectors | Tools | Help HEIDELBERG

.:ﬁ fﬂ a gl £ B B g @) v

MNew Product Part Master Pages Binding Marks Plates Schemes Contents Press Sheet

Press Shest Inspector 123456Prinect2021654321_Job [D with Formatter_100002/ Product Part: A Graphics X

| S e e e il e e e e e e e b e e i b e b

- Prinect2021654321

4

Selected Mark
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2 Marks & Text Replacer

2.2 New Text Replacer "$[SegmentName]"

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

Until Prinect version 2020, the placeholder "$[SegmentName]" was only used at a "segmented fold-
ing sheets" (pixi books).

We want to use the same placeholder to output the name of "segment templates" (Chapter 8 - Gang-
ing with Segments).

Description

The placeholder "$[SegmentName]" has always replaced the name of "segmented folding sheets".

v g IR v s = a
Job Product Part Master Pages Binding Plates cheme: Contents Output Pre it

Master Pages | _unnamed/Praduct Part: A Graphics

and Trimmed Size Folding Sheet Page List Press Sheet List

Page-related Bleed

Ble

‘¥ Custom Bleed and Trim Allowance
Custom Bleed Values

.
]
2

Trim Allowance for Pages

- Segmented Folding Sheets

Size of Single Segment/Page after Separating Cut
Nidth: 105.0 Height: |105.0

yment Order on Folding Sheet Page
X 1 ¥oo4

.
2
=

D : > [100

| Z © | @ | > M

Placement rule for assigned pages

b=
U
o)

N1 P=-f1

File | Edit | Jobs&Resources | Inspectors | Tools | Help

Machines MDS
» 1 Job Templates
» 23 Product Part Templates
+-=) segment Templates

-

owed Segment Parts:

} C1 Plate Templates

Note: This both features are absolutely different!
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2 Marks & Text Replacer

The mark can be placed on:

+ a segment signature
+ a segment folding sheet/montage block
+ on a single page

- If the mark is placed on the paper, subject or printed sheet, all segments on it are replaced with
the placeholder separated by commas.
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2 Marks & Text Replacer

2.3 New Text Replacer "$[SheetregionOutputindexinGroup]"

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

For folding sheet identification at the feeder, the sheet index within the group must be known.
Therefore, the text replacer "$[SheetregionIindexInGroup]" already exists.

For using 'Reverse Folding Sheet Order within Groups' we need a placeholder to recognize the output
order.

Description
For this purpose we have a new text formatter: "$[SheetregionOutputindexinGroup]".

Using the function 'Reverse Folding Sheet Order within Groups' in the TOV Scheme, we need this text
replacer — instead of "$[SheetregionIndexInGroup]" — to output the actual order of the folding
schemes withing the group.

Example: The output order for 'Reverse Folding Sheet Order within Groups' is "4".

y 3 / Z, == —2)
3 - o g B2 2« ) M &
New Product Part Master Pages Binding Marks Plates Schemes Caonten Press Shee
B A-Imposition Schemes | 20190307_Mew text replacer_0001/Product Part: A Graphics X
Folding Sheet Page List Press Sheet List Document

Me »

Number Printing Plate

Bottling Pr eet Layout
1:.CD

132

i
|« e N S v B4

W:{0.0mm [ H:[0.0mm 112 % * Colored =
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2 Marks & Text Replacer

2.4 Collating Mark - "Offset orthogonal”

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

Basically, collating marks are set automatically for Perfect Binding and should not be edited by the
user afterwards. The "Collating Mark" is always placed centered at the cutting box (green line).

We have a customer who wants to define the "Collating Mark":

- For saddle stitched brochures with only FO4 schemes too at an outer position!
+ He also ignores the cutting box and cuts manually!

In this special case the "Collation Mark" would be placed into the page bleed - he wants to move it.

(/ ol == - 5 )
\ 'V L] [ ] & : B
Joh Product Part Master Pages Binding Marks Plates 2 Press Sheet

Marks | _Collating Mark Outer/ Product Part: A Graphics
@|’ + |> Page List Press Sheet List Document
Folding S

@~

Fold Lay Mark
Tup ID

T
|
L +|
|
1=
T

Colors and scal

outer [ Athead

v o EN R e L)

Description

We can now move the "Collating Mark" outwards (positive values) or inwards (negative values)

Colors and scaling for automatic marks

foot Outer
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2 Marks & Text Replacer

2.5 Collating Mark - "Use Rotated Collating Marks"

Motivation

With the implementation of the "Auto Marks Configuration" (next chapter) as a resource, we have to
move some marks "Preferences" into the job.

Description

The attribute "Use Rotated Collating Marks" has been removed from the preferences settings and is
located in the Marks tab now.

] - ) o YA : =
Mew Froduct Part Master Pages Binding Marks Flates Schemes Press Sheet

|F A-- Impaosition Marks _Collating Mark Quter {_Caollating Mark Not rotated.sdf) / Product Part A Graphics  x

q|’ + |’ Page List Press Sheet List Document

Folding Sheet

Colors and

Height:

foot [ outer [ Athead

From:

stfoot (1 outer [ &
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2 Marks & Text Replacer

2.6 Checking Mark Positioning During Output

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation
During outputting Signa Station is checking automatically if marks are
+ in the gripper margin
- outside of the paper
If this is the case, a warning dialog is displayed before output process will start.
Customers wants to disable warnings for some marks.
Description
Special mark types are excluded from this warning
- Plate control marks + Default 'RegisterLine' mark - Scavenger Mark
+ Print quality strip + Pull lay
The following marks are also excluded from check due to compatibility reasons:

« Marks with the name 'PullLay’, 'RegisterLine' and the mark 'Text' in the 'Standard' group.

We can now disable the marks check in the marks editor.
In the Marks Editor the check box ‘Do Not Check Mark During Output' is now available.

1 Marks Editor: MarkMarme — O ®

O
£ 2
b
T

Prinect 2021

BEEg=
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2 Marks & Text Replacer

Mark with enabled attribute ‘Do Not Check Mark During Output' will not cause a warning.
File | Edit | Jobs&Resources | Inspectors | Tools | Help

> ® = 2
3 a 0 = 2 YN | =
Mew Master Pages Binding Plates Schemes Contents Qutput Press Sheet
Print Job. Qutput | P2021_Collating Marks_? / Product Part A Graphics
Output Parameter Set Folding Sheet Page List Press Sheet List Document

Job: JDF
+

Press Sheet List

Prinect Signa Station Server: Information

»
|
»
|5
| 4
»
|
»
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3 Automarks

3 Automarks

Motivation

Especially customers with MIS connectivity wants to have a Signa Server layout with "Folding sheet
marks" for finishing on special places.
Example: Barcodes for "Kolbus" binder or "Mueller Martini" stitcher.

We need mark sets and rules to place marks for different binding intents on different places for cover
and body.

Example Perfect Binding:
The job should have at the "Cover" a:
+ "Folding Sheet Mark" in "Asir Code" on the "back side" in the middle of the "Routing Margin"...

+ "Folding Sheet Mark" as "Text Mark" on the "front side" at the bottom right position

Klebebindung
KALDEWE!

SCHONSTE

BINDUNG AUS
SINNLICHKEIT
UND VERSTAND.

For the "Body" folding sheets we need a:

- "Collating Mark" at the front side in the "Routing Margin" centered middle
- "Folding Sheet Mark" in "Asir Code" at the front upper right position

« "Folding Sheet Mark" as "Text Mark" at the front bottom right position

Asig
CGlatte

ROUND OR SQUARE
ALWAYS ELEGAN

At the moment we have to do this manually and we want to achieve this result by loading mark sets
or automatically.
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3 Automarks

3.1 Automarks as a Resource

Motivation

Some customers wants to define the marks handling individually for different work modes, different
binding intents and different formats.

It is only possible to specify marks globally for new jobs in the "Preferences” for the modes:

+ Imposition
+ Montage
+ Packaging
Signa Station 2020.10 Preferences

5l Preferences

Import Output Licensing Ganging Optimization User Interface Packaging
General : Names Defaults Resources Reports JDF Import

Marks Default (Work Mode: Imposition)
Type Hotspot Name - Group
ut I Middle middle CutMark - Standard
Collating Mz Middle middle CollatingMark
Fold Mark: Middle middle
Folding Cro. Middle middle
Folding Sheet ( Middle middle
Folding Sheet Regi a Middle middle
Fold Lay Mark Middle middle
Aup D Middle middle
T1up Cover Clip Path Mark Middle middle

O
O
O
O
O
O
O
O

Folding Sheet Label 1 Lower left

Marks Default (Work Mode: Montage)

Type Hotspot Name - Group
Cut M Middle middle <- Standard
Precutting M Middle middle

Middle middle
Tup D Middle middle

Middle middle

Lower left

mbly Block Label 2 Lower left

1Ooo0o0oof0 s

Armneahb Dlact | ahal 2 Lnusnr Inft CoamalahIn AT stk Aarke

Marks Default (Work Mode: Packaging)
The rr aults inthe P ing’ mode are located in the
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3 Automarks

Description

We have two different cases:

1. New Signa Station installation

No dialog informs about "Migration of automatic placed marks".

2. Starting up Signa Station after a upgrade

Automarks are converted automatically from the old Preferences > Marks settings.

+ Converted-AutoMarks-Impositioning
+ Converted-AutoMarks-Packaging
 Converted-AutoMarks-Montage

Information dialog after a successful migration of automatic placed marks.

= | Prinect Signa Station 106+: Information
i 21094 ©  Migration of automatic placed marks

Explanation:

The Migration of the autormatic pla

M Note: This dialog does not come up, when the old defaults are identical to the Heidelberg
factory defaults.

The mark sets are stored in the "Resources > Automarks Configuration" in the group "Converted".
A new Signa Station installation or an upgrade with factory defaults has only the folder "Standard".

File | Edit | Jobs&Resources | Inspectors | Tools | Help

Machines
}-C1 Job Templates
-3 Product Part Templates
»-C1 piate Templates Naothing
}-C1 Schemes
-*

24 Auto
Ink. . T
p-C1 Marks
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3 Automarks

3.2 Marks Preferences in Signa Station

Motivation

Because we have now "Automarks" as a resource, we do not need the marks tab in the preferences.
Description

Signa Preferences Prinect 2020.10

In previous Signa Station versions we had an own marks tab to define defaults for 3 work modes.

5 Preferences

Import Processes Output Licensing Ganging Optimization User Interface Packaging
General Paths Names Defaults Resources Reports JOF Import

Marks Default (Work Mode: Imposition)
= Type Hotspot Name - Group

Cut Marks Middle middle CutMark

O
Fold Ma Middle middle

|
T  Collating Marks Middle middle Collatinghar
||
Wy

Marks Default (Work Mode: Montage)
= Type Hotspot
_. Cut Marks Middle middle
:n Precutting ks Middle middle

Cower [En

Marks Default (Work Mod
The marks defaults in the 1g° mode are located in the "Packaging’ tab 3

Signa Preferences Prinect 2021
In Signa Station 2021 we do not have a marks tab in the preferences anymore!
We will find "Defaults for automatic print control marks" in the tab "Resources":

+ A new installation has defaults from the folder "Standard"
- A Signa Station upgrade with converted Automarks takes the defaults from folder "Converted"

- The Signa Server takes this "Automarks Configuration" to create new layouts

ﬁ Preferences *

Import Processes Output Licensing Ganging Optimization User Interface Packaging
General G Names Defaults Reports JDF Import

Set Defaults for New Jobs
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3 Automarks

Signa Preferences Prinect 2020

In previous Signa Station versions we had many options in "Defaults > Switches for Marks Handling".

5 Preferences

Import Processes Output Licensing Ganging Optimization User Interface Packaging

General Paths Names Resources Marks Reports JDF Import
Rlead Nefanlt

Bleed 20 in routing margin: | 3.0
Defaults for folding sheet generation

Routing Margin Min.: 20

Subject Settings
Center subject Include Gripper Margins and Non-Printable Margins
Switches for Marks Handling
[ cutm
nd Fold Marl

totated C
Print Order of i

Signa Preferences Prinect 2021
A lot of these options are now to be found in the Automarks Configuration and in the job.

In the preferences we now have only two global options in the dialog:

5 Preferences x

Import Processes Output Licensing Ganging Optimization User Interface Packaging
General Paths Names Resources Reports JDF Import
Bleed Default

Bleed: 20 in routing
Defaults for folding sheet generation

ing Margin Min.: 20

Subject Settings

Switches for Marks Handling

Suk ped M ntered on Plate [ Invert Print Order of Marks

- Subject Clipped Marks Centered on Plate:
Color control marks with enabled "AutoClip" are automatically centered on the plate.

« Invert Print Order of Marks:
By default, the marks are printed in the following order:
1. Page-related marks
2.Folding sheet-related marks
3.Subject-related marks
4.Paper-related marks
5.Plate-related marks

This means that the plate-related marks are printed over the other marks.
When this option is enabled, the marks are printed in exactly the reverse order, in other words,
the page-related marks are printed over all the other marks.
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3 Automarks

3.3 "Automarks Configuration"

We can create or modify "Automarks" defaults for job creation at two places:

+ In "Resources" => without visible result

+ From a job => visible result

3.3.1 Create / Modify a Automarks Configuration in Resources

Motivation

For basic "Automarks" defaults we have to create them in "Resources" like we have done it in previ-
ous versions in the "Preferences".

Description
There are three different work modes available for creating "Automarks":

-+ Automarks Configuration for Imposition
- Automarks Configuration for Packaging

+ Automarks Configuration for Montage

File | Edit | Jobs&Resources | Inspectors | Tools | Help H=ID=LB=RG

Machines MDS
3 Job Templates
b 21 Product Part Templates
»- 1 segment Templates Nothing selected!
b C1 Plate Templates
»-£1 schemes

¥ ) Automarks Configurations

+ £ standara
+-E1 Marks
}- 3 Page and Pape
b C1 Plate Layouts
| S| Output Parame
(S} Report Header
b3 Sheet Optimizi

] Import Autornark Configuration...

| S| Ganging Optim
| S| Ganging Optim
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3 Automarks

A new created "Automarks Configuration” is identical to the previous "Preference > Marks" defaults.

"ﬁl Autornarks Configurations Editor: Saddle Stitched Brochures

itched Brochures - MyAuto

Automatically Placed Print Control Marks

Icon | Type Hotspot

Middle middle

Fold Mar

Confine to Folding Sheet
QOnly on Folding Sh

[ maton Foldin q

Name - Group

Reset

We can modify the existing "Automarks" in the folder "Converted", the "Automarks Configuration" in

the folder "Standard" are write protected.

N Note: Do not forget to define new created defaults in the "Preferences > Defaults" tab.

Prinect Signa Station 2021 - What’s New
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3 Automarks

3.3.2 Create a new "Automarks Configuration" from Job

Motivation

For complex "Automarks Configurations" it is much better to save it from a job, because the result is
displayed in the User Interface.

Description

The used "Automarks"”, configured in "Preferences > Defaults", are displayed in the job marks tab.
File | Edit | Jobs&Resources | Inspectors | Tools | Help

3 : g

[RE b Master Pages Binding Marks

1

Flates Schemes Fress Sheet

i Standard-PB Marks | _unnamed/Product Part: Standard-PB Graphics

@|’ + " Page List Press Sheet List Document

Auto

Folding Sheet
Automatically Placed Print Control Marks i
Icon | Type Hotspot | Name - Group "’ |>
< g
@p

ooooo/efC e

Midth: |[100.0 % Height:
“ % s L2

Auto Printing Colored |

Advanced Settings for Cut Marks

Example: We want to create an "Automarks Configuration" for a "Perfect Binding" job with:
+ "Cut" & "Folding" marks

+ "Collating Marks"
- Different "Folding Sheet Marks" positions for different folding sheets

Cut & Folding marks are defined by default.

W' Standard-PB - Imposition Marks _unnamed / Product Part: Standard-PB Graphics x
uit qurat el @|’ + |’ Page List Press Sheet List : Document
Folding Sheet
Automatically Placed Print Control Marks
Icon | Type Hotspot | Name - Group f; ‘D
| | arks Middle ... | CutMa dard < Gk
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O
O
|
O
O
O

olors and scaling for automatic marks

Type: Folding Shest Lat Mame - Group:
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3 Automarks

"Collating Mark" should be ignored for Folding sheet 1 (Cover).

Result: The Collating Mark is visible at the second sheet on position 2.

\Y { . L
MNew Job Binding

i‘ Standard-PB -- Imposition Marks

B+

Autah

Automatically Placed Print Control Marks

1 Type Hotspot 5 |D

O
O
0
O
O
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Marks
_unnamed [ Product Part: Standard-PB

Page List Press Sheet List
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3 Automarks

3 different "Folding Sheet Mark" positions for different folding sheets.
1. A "Folding Text Mark" for all folding sheets at the right side of the first page.

We have to create a correct mark in the "Marks Editor" - the mark dimension should be so small as
possible!

|5f"|obid1 S st e S HHS et A HEHR R S A e S e e

Result: The text mark is now placed on all folding sheets at the same position.

> , T = e 7
L \ Y/ L) (] '@. 28 B R
MNew Joh Product Part Waster Pages Binding Marks Flates Schemes Press Sheet

f Standard-PB -- Imposition Marks _unnamed / Product Part: Standard-PB Graphics
Autom figuration: | PerfectBinding - MyAutomarks * @|> + ‘» Bepslis eSS hetifist - ocoment
Folding Sheet
Automatically Placed Print Control Marks
lcon | Type Hotspot Name - Group
B FoldLayMark Mid i
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- W H: 1 w Colored |

Do not forget that we can shorten all replacers easily.

ESﬁ'obidW - S[fokbname] = P3: $S[Sheet:-21 ~ F3: S[FoldingSheetID:-2]

Result: A customized text mark.

y 01 - Perfect Bind Job - P5: 01 - FS: 00
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3 Automarks

2. A "Asir" bar code mark for the first folding sheet only.
We can create Bar codes in Signa Station "Marks Editor" - the "Hotspot" should be "Middle middle!

Result: Only on the first folding sheet we want to have a ASIR bar code inside the routing margin of
the inner pages (back sheet).

C —)
(] U @ B ) 4 R
Product Part Master Pages Binding Marks Plates EEE Caonti Press Sheet

H  Standard-PB ke _unnamed / Product Part: Standard-FB Graphics ¢

Page List et Li ment
iguration: |Auto asition - MyAuto e i
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Name - Group ' + I
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¥ Color: ( r
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i
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+ aied o | ~ssy aBed oy

lding Sheet

First Firstin ¢
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%

Auto Printing Pla
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3 Automarks

3. A "Asir" bar code mark for all inner folding sheets.

Result: A "Asir" bar code mark for inner folding sheets only, on the right side of the first page (front).

{/ /i
W L a 4

[l e Job Product Part ste s Binding Marks Plates Schemes Cont
' Standard-PB-- Imposition Marks | _unnamed [ Product Part Standard-PB

S @|’ + |’ Page List Press Sheet List

cally Placed Print Control Marks -
1

2
Type Hotspot Name - Group £ |>

Fo K dard -

1up ID

Juawubissy

W: (0.0
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Now we want to save this complex "Automarks Configuration”.

3 Automarks

= Note: A changed "Automarks Configuration" is displayed with a "*".

We copy the actual "Automarks Configuration" from the "Internal Resources" of the job...

\"Y/
Job Froduct Part
Current Joh:01_Perfect Bind Job

£

Internal Resources
O Product Part Templates
O Segment Templates

b C1 plate Templates

b ©1 Schemes

1 Automarks Configurations

F- 1 Marks 2 b Tternal Autom

nternal Automa

| S| Papers (Printing Materia E’f
b C1 plate Layouts

- Output Parameter Sets

3 | Sheet Optimization Setup

File | Edit | Jobs &Reso | Inspectors | Tools | Help

1
Machines MDS

» £3 Product Part Templates
| S| Segment Templates
¥ C1 Plate Templates
b1 Schemes
—£J Automarks Configurations
2 4

.

(S

¥ Marks

/] 4
Master Pages Binding

@  A-- Imposition

onfiguration: | AutoM

TUp I

Sheet Label Parameters
Parent:

Position: Right

ar
Placement:

Confine to Folding Sheet
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3 Automarks

We can rename the configuration in the context menu or...

File | Edit | Jobs&Resources | Inspectors | Tools | Help

Machines MDS
} £3 Job Templates
3 Product Part Templates
[} Segment Templates

3 schemes

3
»- 3 plate Templates
»
v

=) Automarks Configurations

»-£01
+ £ Marks
} 3 Page and Paper Sizes
+ £ plate Layouts

... inside the "Automarks Configuration".

Result: All our job dependent settings are saved in this configuration.

) Automarks Configurations Editor Impositioning: PerfectBinding - O X

Automatically Placed Print Control Marks
Icon | Type Hotspot Name - Group
BB FoldLay Mark Middle mi
Tup ID Middle mi
Path Mark Middle middle
er Middle middle

eft

Folding Sheet Label
round
Width: | 100.
T All Bann
Sheet Label Parameters

Firs

Confine to Folding Sheet

First
anly

not
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3 Automarks

3.3.3 Load an "Automarks Configuration" into a Job

Motivation

It should be possible to load a saved mark set.
Description

We have two options to load an "Automarks Configuration":
1. Load an "Automarks Configuration”

2. Add different "Automarks Configurations" with different "Rules" - next chapter

7 ’ / - = =)\ =
" - () (] L & ) (R
Mew Product Part Master Pages Binding Marks Plates Scheme Press Sheet

f A-- Imposition 'I 2 _Perfect Bind Job / Product Part: A Graphics

@|’ + |’ Page List Press Sheet List Document

At
Folding Sheet

Automatically Placed Print Control Marks

Icon | Type Hotspot it
Bl

O Collating Marks Middle middle
M Middle middle

Load an "Automarks Configuration" (1) opens the resources of "Automarks Configuration".

Here we can load ONE "Automarks Configuration" for the whole layout.

5l Choose Mark *

erfectBinding
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3 Automarks

After loading the "Automarks Configuration" we have automatically the same result as described in
chapter 3.3.2.

File | Edit | Jobs&Resources | Inspectors | Tools | Help

\ Y ] (] L] - R
Mew Job Product Part Master Pages Binding Plates EEEH Press Sheet
ﬁ‘ Standard-PB -- Imposition C _unnamed / Product Part: Standard-PB Graphics
Press Sh ment

MyAutomal
ing Sheet Page List

Automatically Placed Print Control Marks | 4 : LA

Icon | Type Hotspot Name - Group 3 0looo

Middle

i < < < M i

Colors and scal

p

only
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3 Automarks

3.4 "Rules" for "Automarks Configurations"

Motivation

We want to configure a set of different marks configurations for the "Preferences". The Signa Server
should automatically take the right mark set for the current product.

3.4.1 Create a "Automarks Configuration with Rules" in "Resources”

Description

In this example we have 3 Automarks Configurations without rules:

1. Automarks-Imposition - a copy from the "Standard" folder for cut and fold marks only
2. PerfectBinding - the configured mark set of the last chapter

3. SaddleStitching - a complex Automarks Configuration for saddle stitched brochures

File | Edit | Jobs&Resources | Inspectors | Tools | Help H=ID=LB=RG
— —

Machines MDS

» 1 Job Templates
L g # MyAutomarks / SS-A4

-1 Plate Templates
-1 schemes

<= Automarks Configurations INothir

We will now combine these 3 mark sets to an Automarks Configuration with rules.

We open the default mark set "Automarks-Imposition”, define a new name and add a mark set from
the resources.

8 Autamarks Canfigurations Editar: PE-55 — O *

Automatically Placed Prin

Icon | Type

Selection of o' reg he current automark configuration..

| 3 .
al/ [ Do not show this window again. Cancel
1up ID : : Upldentifier- Standard

|
I
|
O |
O M|
O =
o T
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3 Automarks

We have to define a rule now:

1. We can define a "Description”
2. The warning displays that no rule is configured
3. We change to the rule tab

4. Add arule

5. Select the rule "Binding"

5 Automarks Caonfigurations Editar: PB-53 - O X

nfiguration: | PB-85 - MyAutomarks
Automarks Configurations Description
B 1

¥k PB-55 - MyAutomarks without rule evaluation

s

Rules

Reset

Signa Station Rule Parameters

- Binding - the "Binding Method" that we get displayed in the job workflow step "Binding"

- Body & Cover - in use when we enable "First Folding Sheet is Cover" in "Binding"

- Customer - we can configure different mark sets for different customers (finishing supplier)
- Page format height & width - we should always try to place marks independent of format
- Scheme - for special schemes like "PushToStop Stahlfolder" marks

Note: We will get more rules like "Product Part", "Product Code"...
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3 Automarks

We add a rule for "Binding".

ﬁ Autormarks Configurations Editor Impositioning: PB-55 — O X

Autom guration: |PB-55

Automarks Configurations Description

M FB-55 - MyAutor

Autom

Binding

Perfect Binding 2+

File | Edit | Jobs&Resources | Inspectors | Tools | Help

New Product Part Master Pages Binding Plates Schemes Fress Sheet
i‘ Standard-PB Binding _unnamed [ Product Part: Standard-PB Graphics
Binding Method Page List Press Sheet List Document
Folding Sheet

In the "Rules" dialog we can:
1. Delete the displayed rule
2. Create an "OR" relationship - Example: OR "Binding Method" "Sewn"
3. Add another rule
Autom gurations
Binding

contains w |Perfect Binding
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3 Automarks

Now we add a second "Marks Configuration" set for saddle stitched brochure.

Group: | MyAutomarks
Mame: |PB-SS

Automarks Conf|

Automarks Co
» =) Automarks Configurations Group: MyAutomarks

¥ MyAutomarks Name: SaddleStitching
B AutoMarks-Imposition Created on: 02.11.2019 Version: PrinectSignaStation 21.00.15
¥ PB-SS Last Modified on: Way 8, 2020 Version: PrinectSignaStation |

ik AutoMarks-

¥ PerfectBinding

2 Type: Impositioning
¥ Standard
Autorarks Cc 4 AutoMarks-Imposition Selected automatic print control marks

Cut Marks - Stanclard / Cutlark

Fold Marks - Standard / Foldingllark

Folding Sheet Label - FoldingSheetMarks [ FoldingSheet-Te

Folding Sheet Label - FoldingSheetMarks /3 x
AsirBarCode-MiddleMiddle

Folding Sheet Label - FoldingShestllarks /3 x
AsuBarCode-Lower iddle

Binding

equals

MName: |SaddleStitching

Cancel

Save

We define the "Marks Configuration" description and add a rule for binding "Saddle Stitc

Group: | MyAutomarks
Mame: FB-SS

Automarks Configuration: | PB-S5 - MyAutomarks

Automarks Configurations Description
] | 1

B PerfectBinding - MyAutormarks PB

4 AutoMarks-Imposition - MyAutomarks without rule evaluation

Automarks Configurations

Binding
3

contains w  Saddle Stitch

Reset
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3 Automarks

Result: We now have a combined "Automarks Configuration with Rules".

) Prinect Signa Station Server - 21.00.20103.3 - m] *

File | Edit | Jobs&Resources | Inspectors | Tools | Help

Machines MDS
+C1 Job Template:
} £3 Product Part Templates
| S| Segment Templates
»-C3 plate Templates
+- 31 schemes

3.4.2 Create an "Automarks Configuration with Rules" in a Job

We can also create an "Automarks Configuration with Rules" from a Job, when we load a second
mark set into a job.

The same dialog pop’s up, when we add a second mark set.

3 ) ) ¢ 0 ) ¢ )& )& -
Mew Job Product Part Master Pages Binding Marks Plates Schemes Press Sheet

f Standard-FPB -- Imposition Mark 1 ! _unnamed / Product Part: Standard-FB Graphics  x

Auton w | Auto P—r. Page List Press Sheet List Document
Folding Sheet
Automatically Placed Print Control Marks
lcon | Type Hotspot

Cut

1up ID Middle ...

oooooleOR
A REHE - E

. Tup . Midd|

Explanation:

Colors and scaling for automatic marks
uto
fullfill the

Cancel
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3 Automarks

Attention: When we enable "Do not show this window again”...
B

"'ﬁl Prinect Signa Station Sereer: Question *

?  4B500: Enablerule |

Cancel

... the Signa Station will hide the "+" button for the next new signature.

This feature was implemented to hide this "+" button, because customers could be confused about
this new feature.

Y [ g & ES &
Jok Product Part Master Pages Binding Marks Plates “hemes Press Sheet

Marks _unnamed f Product Part: A Graphics
Page List Press Sheet List Document
uration: | AutoMark
olding Sheet
Automatically Placed Print Control Marks
Icon | Type Hotspot Name - Group

M

- Note: We can enable the "+" button display again in Signa Station "Preferences > General
> Suppressed Messages".

In chapter "3.3.2 Create a new "Automarks Configuration" from Job" we can read how to save
a job mark resource (Copy & paste of the internal job marks resources into the Signa Station
Resources and rename it).

d  Standard-PB - Imposition _unnamed/ Product Part: Standard-PB Graphies

AutoMa Page List Press Sheet List Document

Folding Sheet
Automarks Configurations

B AutoM position - My

No Page Assign... || No Page Assign... | [No Page Assign... | No Page Assign

» Perfect Binding
3

ign... | Mo Page Assign... | Mo Page Assign... | Mo Page Assign..
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3 Automarks

3.4.3 Load an "Automarks Configuration with Rules" manually into a Job

Now we create a saddle stitched brochure in Signa Station and load a "Automarks Configuration” with
different rules. After loading such a marks configuration...

() = e - —5)
¥ \Y 4 ] G @& | 55
Mew Joh Product Part Master Pages Binding Marks Plates £ 5 Press Sheet
W Standard-ss Marks | _unnamed/Product Part Standard-SS Graphics X
Page List Press Sheet List Document

2
Autor guration; | Autah on - Standard @‘» +‘»

Folding Sheet
Automatically Placed Print Control Marks
Hotspot Name - Group 4 |>

oo

Pl DOoo0o0ooRON

Selected automatic print control marks

Cancel

... all combined "Automarks Configurations" are displayed in the job.

In this example only the first mark set AND the third mark set is in use, because the rule "Perfect
Binding" is not in use.

' Standard-55 - Imposition Marks | _unnamed/Product Part: Standard-SS Graphics X
Page List Press Sheet List Document
Autormar ation: |PB-SS - MyAutomarks * ﬁJ_|> + |> <k = = e
Folding Sheet
Automarks Configurations Description

e-MiddleMiddle - Fol

Scale Width: |100 Height:

Sheet Label Parameters

B E

In a gang job it can happen that different mark sets for different jobs are in use.
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3 Automarks

3.4.4 Load an "Automarks Configuration with Rules" automatically into a Job

Motivation

We want to use an "Automarks Configuration with Rules" automatically in the workflow.
Description

We can define the "Automarks Configuration with Rules" in the "Preferences" to use it for a:
1. New layout generation in Signa Station

2. Automatically generated layouts from Signa Server for job import via W2p, CSV, JDF, XJDF or
JASON.

At first we have to define an "Automarks Configuration with Rules" in the Signa Station Preferences.

Bl Freterences L

Import Processes Output Licensing Ganging Optimization User Interface Packaging

General Paths Names Defaults Reporis JDF Import

1

Set Defaults for New Jobs

Default for Resources
d Template:

Created on:
Last Modified

Mame:
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3 Automarks

1. When we create a new layout in Signa Station manually we automatically have the defined
Automarks Configuration preassigned for this job.

& [ ] &
Froduct Part ster Pz 3 Binding Marks
Marks | _unnamed/Product Part: A Graphics

Page List e et Li Document
Folding Sheet

Automatically Placed Print Control Marks
Hotspot Name - Group ‘, |>
| C Middle m
[l Midd

L]
Froduct Part Master Pages Binding Marks
Marks
Document
Folding Sheet
Automarks Configurations Description
a0 00000

W Pe
4 Autoh

R
Automatically Placed Print Control Marks

Type Hotspot Name - Group 6 ‘»

wsuLBiss y 2Beg o

No Page A ssignmert

Mo Page Assigrment

| R R R Ry < R <

Colors and sc:

W00 H:|0.0 Auta Printing Plate
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3 Automarks

3.5 Alignment of Job Internal Resources

Motivation
We have to compare job internal marks resources with the actual marks resources.
Description

When opening a job, the internally used "Automarks Configuration" will be compared with the actual
marks resources. If a difference is detected, the user has the option to keep the job resources or to
use the actual Signa Station resources.

T Prinect Signa Station Server: Question >

? 210896 0 Internal automarks configurations check!

= EREHN

ifferent to that in the resource pool.

[] Do not show this window again.

In Prinect 2021.10 we plan to implement much more Marks Configuration features:

- Save button - for Marks Configuration in the job tab "Marks"
» Show Automarks - display of marks of a Marks Configuration in the Graphic view
- Further filter criteria:
- MIS Product Parts
- Product Code
+ Further positions
- Spine - inner and outer
- Gripper fold rear - inner and outer
- Gripper fold front - inner and outer

« Press sheet label
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4 Imposition Automation

4 Imposition Automation

4.1 New Attribute "Automatic Gap Computation”

Motivation

In the work mode "Imposition" and "Automatic Imposition", gaps can be created in the workflow step
"Scheme" by clicking on the button "Automatic gaps".

It would be nice to activate this action automatically for jobs and product part templates.
Description

In the workflow step "Binding", there is now a new check box "Automatic Gap Computation".
Signa Station calculates automatically all gaps for every sheet. "Use for JDF Import" can be enabled
for "Signa Product Part Templates" referenced by "MIS Product Codes".

2 £ == ~)
L] W, L] 0 ; EE) B /-] 2
New Job Product Part Master Pages Binding E EICH chemes Contents Press Sheet

B Standard-S5 - Imposition Binding | _unnamed/ProductPart: Standard-SS Graphics

a Folding Sheet Page List Press Sheet List Document

FoldRear O GripperFold Front
Mo Page Assigrm...| No Page Assigrm... | o Page Assignm... Na Page Assigrm...

Glue Line O ling O ByClipping Only

JOF Import

- (2 f oot ES, =o )
L] \ Y/ L] (] & /] 2
New Job Product Part Master Pages Binding Marks Plates Sthemes Contents Press Sheet
|i‘ Standard-55 Schemes _unnamed / Product Part: Standard-58 Graphics

nt Master Schemes Folding Sheet Page List Press Sheet List Document

Number Printing Plate @|,
&)
1: XL106 - Drupa (Perfecting) o

Mo Page Assigrm. .| No Page Assigrm... [ Ne Page Assignm... No Page Assigrm...

Bottling [F

A

Mo Page Assigrm...| No Page Assigrm... [ No Page Assignm... No Page Assigrm...
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4 Imposition Automation

4.2 "Max. Foot Trim" for "Automatic Gap Computation”

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation
We do not have a foot trim definition, but this is necessary when customers wants

- to place folding sheet labels at the foot
+ run multiple Tups in postpress so close as possible defined by head and foot trim

Description

We can now define a "Max. Foot Trim" in the tab "Binding" and in "Preferences > Defaults".

a ¥ / o B o) 5
(7 \ L) [l 3 B 73
Few Job Product Part Master Pages Binding ( Plates Schemes | Fress Sheet

f Standard-55 -- Imposition Binding _unnamed / Product Part: Standard-55 Graphics

- Page List Press Sheet List Doc
Folding Sheet

[J AutoBottling

Gripp ator / Cover Bonding / Glue Line
e @ GripperFoldRear O Gripper Fold Front

Glue Line: O none O ByMoving O ng O By Clipping Only

Parameters for Automatic Gap Computation
Automa ation [] DF Import

B E e

H Colored =
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4 Imposition Automation

4.3 JDFs without Cover Information

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

We can reference "Signa Product Part Templates” by "Product Codes". When a MIS job with the same
product code comes into the Prinect system the Signa Server will use this product part template to
create the layout.

Note: The Signa product part template must use the same folding schemes as the incoming
MIS-JDF.

Until Prinect version 2020.10 we needed two different product part templates, because MIS Bro-
chures do not always have a cover with 4 pages at the first sheet:

1. Product part template with cover (enabled function 'First Folding Sheet is Cover')
2. Product part template without cover
Description

In the "Preferences > JDF Import" we can now "Ignore cover from Product Part Template when no
cover is specified in JDF".

With this setting we need only one product part template for both cases - the first one.

"ﬁ] Preferences =

Import Processes Output Licensing Ganging Optimization User Interface Packaging
General Paths Names Defaults Resources Reports

Default for Product Part
Pro
ended Mode

Default for Product Codes Search
Product Part Tem roup: | Drupa

Resources Default for JDFs with Job Prep Data
Output Parameter Set: XL106 - Drupa
Resource Group Default for Search

Plate Template: Drupa

Drupa

ding Sheet
rder far JOF Impol ended: QM)

P

mplate if Mo Coverin JOF

JDF Import Rules Editor
[ Use Rules

Note: This setting only affects product part templates when the setting "Match Folding
Sheet Count to Page Total" is activated.
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5 Ganging in General

5 Ganging in General

5.1 Gang Filter and Gang Tasks as Resources

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

Customers with a lot of "Gang Filters" and "Gang Tasks" wants to have a structured view to manage
them.

Description
With Prinect 2021 "Gang Filters" and "Gang Tasks" are displayed in the "Resources":
+ Ganging Optimization Tasks

- Ganging Optimization Filter

5 Prinect Signa Statian Server - 21.00.20103.3 — m} X

File | Edit | Jobs&Resources | Inspectors | Tools | Help =ID=LB=RG
— — —

Machines MDS
» £3 Job Templates

» 3 Product Part Templates
}- 1 segment Templates D Flyer / 01 P-Flyer-2_300
b1 plate Templates

b1 schemes

b1 Automarks Configurations

b 51 marks

[ S| Page and Paper Sizes

» 1 plate Layouts

+ C1 output Parameter Sets

+ £1 Report Headers

»£1 Sheet Optimization Setup

Note: After upgrading Signa Station existing Gang Filter and Gang Tasks of previous Signa
Station versions are automatically in the folder "Converted".
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5 Ganging in General

5.1.1 "Gang Optimization Filter" as Resources

Motivation

Because customers have a lot of different filters, they want to manage them centralized.
Description

Filters are to manage in the resource group "Ganging Optimization Filter".

We can create, sort in groups, copy & paste, rename, edit and lock the filter.

¥ £J Ganging Optimization Filter
| S|
| |
[ S

5 Filter Rules >

[ Filter by Printing Material Quality [ Filter by Shape
' . ' ’ Add Filter Rul...

Printing M

equals

8

Produc

Components that must be in the product code

02P-Flyer 9

Components that may not be in the product code
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5 Ganging in General

The Gang Filter can be used for:

1. Automated Gang Tasks - next chapter
2. Manual "Job Import from Gang Pool"
2. Manual "Job Import from Gang Pool"

We can load the saved filter from the "Resource" pool and filter all jobs with the same criteria.

% Jab Import from Gang Pool

Fiter O offt O Pri

Product Code = Printing Material + Grammage 5 Target Date = Delivery Qui i3

k: Ma 1

300.00 May 1000

U} 1000
[} 1000
1000

300,00 E 2 Al 1000

Log of Job Import

O Fitter by Printing M
O Fitter

® Frinting
B4 Printin ©|ProductCote 2 Printing Matoral 2 Grammage * Target Dale

Prod

Log of Job mport

Components that must b

02P-Flyer
Create Gang Job

rimport Select All Close

~ Product Code + Final Size Printing Material =

g of Job Import
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5 Ganging in General

In the "Job Import from Gang Pool" dialog, we can switch between three options:
1. Filter "Off" - no filtering
2. Filter "Private" - the last configured filter is available on the local Signa Station computer

3. Filter "Resources" - the filter is available for all Signa Station computers, when they are using
the "Global Preferences”

5 Job Impert fram Gang Pool - O X

Filter:

Job + Product Code very Qus: £7

M20-0001 gJo or ging g 3 ay g 1000 -
M20-0001 fo g g 1000
M20-000101/¢ or >-Fly 1000
M20-0001 q fo g o-Fly 3 ! 1000
M20-00010/ gJobs fo ging ging/ 3 R 1000
M20-00010/C aing 1000
M20-0001 g ging ging jer E 1000

Total: 7, Filtered:7, Selected: 0
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5 Ganging in General

5.1.2 "Gang Optimization Task" as Resources

Motivation
Because customers have a lot of different tasks, they want to manage them centralized.
Description

"Planned Gang Tasks" are to manage in the resource group "Ganging Optimization Tasks".

We can create, sort in groups, copy & paste, rename, edit and lock filters.

(S} Ganging Optimization 1

For a "Ganging Optimization Task" we need a "Product Part Template" (6) and a "Gang Pool Filter" (7).

5 Ganging Optirnization Task: XL106-Fhyer-2-300 — O X

[ Automati
Trigger
v M Time 4
ill be run Mon Tue wed Thu Fri B sat sun daily
Starttime ay 0 v O end: | May 11,

Time:

a)[w] [4lle] [2)0e] (<)0m

06:00 PM

» [ Event

Job Data

Template/Filter

g Pool Filter:
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5 Ganging in General

5.2 Activated "Planned Gang Tasks"

. Note: After upgrading Signa Station existing Gang Filter and Gang Tasks of previous Signa
Station versions are automatically in the folder "Converted".

Motivation

We need to define a resource path to activate "Ganging Optimization Tasks".

Description

In the "Planned Gang Jobs" we have to define a path for "Active Task Group" (2-3).

Only tasks inside this group can be active (we can disable a task) for scheduling gang tasks.

55 Prinect Signa Station Server - 21,00.20108.3

»£3 Job Templates

» £ Product Part Templates ) .

S e usinessCards / XL106-BC-2-300
»C1 Plate Templates )

b7 Schemes

¥ 1 Automarks Configurations: 5 Plsnned Gang Jobs

»-C1 Marks

»£3 Page and Paper Sizes 1

1 prste Loyt ?e‘ Planned Gang Jobs

b £1 Output Parameter Sets —

»C1 Report Headers

nization Tasks
Properties

< Duration < Started by User

Save Cancel

Optimization Filter
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5 Ganging in General

5.3 "Create Prinect Job" for Ganging

. Note: The main part of the feature was implemented in Signa Station 2020.10.
2020.10

Motivation

We want to define in a "Product Part Template" AND in the "Ganging Optimization Task"
that the "Gang Server" can create a Job in the "Cockpit "OR in the "Prinect Business Manager".

Description

1. We can define in the "Product Part Template" that this template can be used to create a job in
the Cockpit or in the Business Manager.

- Integration Manager (Cockpit) - job number and job name required

) Product Part Template Editor: GangForm-XL106-2-300 X

Qg B 9] R
Product Part Plates Optimization Press Sheet

GangForm-xL106-2- Product Part _GangForm-XL106-2-300 / Product Part: GangForm-%L106-2-300 ( §[Date:@dd... Graphics
Assembly Block 1up List Pres:  List

Subject

- Create P

(printed area)

ubjec

(printed area)

Note: The used "Plate Template" in the "Product Part Template" has to define the right "Out-
put Parameter" for Cockpit or PBM output!

Prinect Signa Station 2021 - What’s New 61



5 Ganging in General

2. ltis also possible to define "Job Data" in the "Ganging Optimization Task".

) Ganging Optimization Task: XL106-Flyer-2-120 - [m] X

General
iption

O Enabled

[ Automatic
Trigger
w [l Time
D e run: Man Tue Wed Thu Fri Sat Sun LT
Start time: May 1 0 - [] End: | May11,

Time:

| =

Joh Data

in the 'Integration Manager'

Note: When "Job Data from Template" is enabled and we browse for a "Product Part Tem-
plate", Signa Station does only display templates with defined "Job Data".
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5 Ganging in General

5.4 "User-defined XML Tags" for Ganging Attributes

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

We can write user-defined attributes into a gang XML-file. These attributes can describe a special fin-
ishing work step or a special behavior for production.

Customer wants to use this attributes as a mark on the placed ganged job.

Description

In the Cockpit we can define up to 5 different user-defined attributes, Signa can handle up to 9.
Fle | Edt | View | Tools | Help |

B ol % oo @ BB R HZID=ELB=RG

1

1
2 G{} Preferences

FrojectlD

“arnishing

This attributes are available for submitting pages or folding schemes into the gang pool.

B8 submit to Ganging X

Submit to Ganging

& 2pa

cted
SIVTIEG o] User-defined Attributes X
Q ity _

Sequen
FID-5500

| &)

Perforating
ProjectlD

Varnishing

4 cancel

User-defined Attributes:  State

Prinect Signa Station 2021 - What’s New 63



5 Ganging in General

After optimization of these jobs in a gang job, Signa Station reads out all user-defined XML-entries,
displayed in the "Preferences".

"ﬁl Preferences =

General Paths Names Defaults Resources Reports JDF Import
Import Processes Output Licensing User Interface Packaging

Default for Sheet Optimization

Setup Template: MSO - dard

1up-bleed - Standard

1up-CAD - Standard

Default for Product Codes Search
Product Part Templ : Ganging
Default for Gang Pool
Gang Pool GangPool -- Wdrupwf00040\PTJobs
User-defined XML Tags (from the gang part XML)
XML Tag Name Marks Placeholder
ProjectiD )

Deliver

Signa Station generates automatically "Marks Replacer" for user-defined gang attributes!

T Insert placeholder *
Name + Placeholder

Deliver

Proj

gna will replace also in the Prinect Prepress Manager and Prinergy worlkdflows, e.

Insert placeholder Close

These "Marks Replacer” are to add to a "Text Mark" and can be placed in the "Product Part Template"
(e. g. as a "Page Label Mark", outside of the page), visualized in the gang form.

When only one attribute is available for the job => only one is displayed at the job,
even when 5 Marks Replacer are defined in the mark.
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5 Ganging in General

Note: We can use the existing "Marks Replacer" "[GangPartUser1]" - "[GangPartUser9]" too.
1

The existing "Marks Replacer" $[GangPartUser1] - $[GangPartUser9] are always mapped to the first
9 entries in the "Preferences"” list. We can change the order of mapping of "User-defined XML Tags"

in this dialog.

@ Preferences
General Paths Names Defaults
Import Processes Output Licensing
Default for Sheet Optimization
Setup Template: MSC - Standard

1up-hleed - Standard

Default for Product Codes Search

Product Part Templ

Default for Gang Pool

Gang Pool: C “ool - Wdrupwfl0040\PTdobs
User-defined XML Tags (from the gang part XML)

XML Tag Name

Deliver Deliver

Prinect Signa Station 2021 - What’s New

Resources Reports JDF Import
User Interface Packaging

&p
&b

Marks Placeholder
ibuteDeliver]
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5 Ganging in General

Note: We can use the user-defined attributes for filtering jobs.

1

) lab Import from Giang Pool

Pool

~ | Product Code + Printing Material = Grammage - Target Date + ProjectiD < Deliver = m
H a

ann nn

Log of Job Import

Mew Job Product Part Results Contents tput Press Sheet

GangForm-XL106-2-120 -- Sheet Optimization without Layout Default 11-05-20-1_GangServer/ Product Part GangForm-XL106-2-120  Graphics

Input List for Sheet Optimization 1up List Press Sheet List iment

Process Order 5 - State + | Article

M2
M20-00010/

el < << |

Import PDF...

11-05-20-1_GangSemverProduct Part: GangForm-XL106-2-120
Press Sheet Segments 1up List Assigned Not assigned
Os
Format Product Part 1ups Deliver Projectid | =
M20-00010-P1 - M20-00... -
M 010-F1 - M
M20-00010-P1 - M20-00...
] P1-M
M20-00010-P1 - M20-00...
] 010-F1 - M

66 Version 2021



6 Ganging Based on Cost or Rating

6 Ganging Based on "Cost" or "Rating"

In Signa Station 2019 we have introduced "Rating" as a new criteria for ganging.
Two settings are responsible for the decision, if Signa Station calculates cost based or rating based:

"Only One Press Sheet"

5 Sheet Optimization Setup Editar: unnamed - O x

Cost Rating

n Plate Template

"Delete Press Sheet with Red State"

5 Sheet Optimization Setup Editar: unnamed - O *

Group: | MyMSO

Mame: |unnamed

Calculation Case 1: Cost based
"Only One Press Sheet": Off, "Delete Press Sheet with Red State": Off
+ Optimization is running on the Cost basis.

- All gang parts are placed.

- Defined Rating criteria results are shown in the Report, but they have only a lower priority for
optimization.

Calculation Case 2: Rating based
"Only One Press Sheet": On, "Delete Press Sheet with Red State": On

+ Only one press sheet is generated.
- Gang parts are placed with the best possible overall rating.
« Unused Gang parts are returned to the gang pool.

Calculation Case 3: Cost and Rating based
"Only One Press Sheet": Off, "Delete Press Sheet with Red State": On

- Based on the quality criteria and taking the cost into account, several press sheets may be gen-
erated because you try to process all the imported gang parts if possible.

- If a sheet has a red rating in the overall rating or in a criterion defined as "Veto", the sheet is
rejected automatically, the unused Gang parts are returned to the gang pool.
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6 Ganging Based on Cost or Rating

6.1 Cost Based Optimization

Cost based ganging compares the relationship between 'Make Ready' costs and '‘Good Production’
costs. The unit for the cost is not relevant, it can be Euro, US-Dollar or British Pounds - the balance
must be correct.

1. Print Preparation (global)
- Make Ready time + Make Ready sheets:
400 € : 60 min x 8 min = 54 € + 6 € for 60 Sheets = 60 €
2. Per separation
- Imaging of Plates + Plate material:
30 € per separation
3. Cost [1000 sheets]
- Print material price per 1000 sheets:
100 € for 1000 sheets glossy coated paper 135 g/m?2
4. Press (hourly rate) - Sheets per Hour
- Cost Center Press: Hourly machine rate + hourly Employee:
400 € per hour
5. 5. Sheets per Hour

- The default speed of an XL:
15 000 Sheets per hour

T Sheet Optimization Setup Editor MSO - O >

Group: | MyMSQ

Mame: [MSO

Placement Rating

oo 1

100.0

400.0 Sheets per Hour | 15000.0
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6 Ganging Based on Cost or Rating

6.2 Rating Based Optimization
General
« Customers are often combining different criteria for one "Sheet Optimization Setup”

- When different critical criteria are in use, we need a lot of jobs in the gang pool, otherwise the
"Gang Task" cannot create good gang sheets

- Tolerant gang tasks are necessary to clean up the gang pool at the end of the day

- We can use "Product Part Templates" in 3 different ways:

55 Product Part Template Editor: GangForm-XL106-2-120 hd

== =
Q @) R
Product Part Plates Qptimization Press Shest

GangForm-XL106-2-120 ProductPart | _GangForm-XL106-2-120/ Product Part: GangForm-XL106-2-120 ( $[Dat.. Graphics

el i ess Sheet Li
Product Pa Assembly 1up List Press Sheet List

Main Features

We have 5 different rating criteria

1. Area Use - looks for one sheet of a Gang job

2. Volume Use - looks for the whole stack of a Gang job

3. Back Use - respects the Back side too

4. Date Spreading - looks for the target date

5. Multiple Tups - tries to avoid multiple 1 up sheets

ﬁ Sheet Optimization Setup Editor: K30 - O x

Group: | MyMSO

MName: |MSO

Delete Pr
Rating Criteria

Multiple 1ups
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6 Ganging Based on Cost or Rating

6.2.1 "Area Use" - looks for one sheet of a gang job

Usage of printed area versus unprinted area in percent.

Unprintable areas are not included (gripper, sheet brakes or margins).

Printing Material Unused area

Printing Material Margin (unprintable area)

Segment

Segment Margin

1Up ‘

1 Up Margin

1Up area
without Margin

Gang sheets with an area usage higher than 80% will be created.

5 Sheet Optirnization Setup Editor: M30 — O X

Group: | MyMSO

Mame: |MSO

2

a use in percent Medium | [] veto i}

P — g0 4
R
] 10 20 30 40 50 60 70 80 90 100

Volume Use

Date

Multiple 1ups
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6 Ganging Based on Cost or Rating

6.2.2 "Volume Use" - looks for the whole stack of a gang job

The rating for volume is only in use in the defined volume range.

The volume usage compares profitably used paper versus printed waste and unused areas. Prof-
itable used paper: Quantity, make ready sheets for post press, overproduction, margins.

Segment 1Upin Segment

L Ms

Qe —

Unused area

Qs = Quantity for gang job We = Press Waste for gang job
On=1Up Overproduction Mn=1Up Make Ready for Postpress
Qs = Quantity for Segment  Ms = Make Ready Postpress for Segment

For "Volume Use" we can define a range of sheets.

5 sheet Optirnization Setup Editor: k350

Dele

Rating Criteria

1

Bacl ﬁ Edit Sheet Quantities * +

Date 1

Mult
Miniry

Maximum Sheet Quantity
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6 Ganging Based on Cost or Rating

Example

+ Gang sheets up to a quantity of 2000 sheets and with a Volume usage higher than 80% will be
created with the volume criteria in the report.

+ When we would have only one volume range, we would generate higher quantities too, but they
would not respect the volume criteria in the report.

Wolum ] +

Volume use in percent  Sheet quantities 0oo - Medium > [ veto W

a0 ) — 90
T T T T T T Y T O A O A
] 10 20 30 40 50 60 70 80 90 100

Geometry Placement

eetwith Red Rating

Volume Use

Volume use in percent  Sheet quantiti - Medium ¥ [] Veto

80 T 1 ] 90

5 Edit Sheet Quantities e

Back L =1 2001

Date 2000w
Minimum Sheet Quar

Multipl

Maximum Sh

When the sheet quantity is higher => the waste volume is larger!

YVolume Use

#  Medium > []veto W

Volume use in percent  Sheet quantities

a0 o — a0
L T e e e e e
0 10 20 30 40 50 60 70 80 a0 100

Wolume use in percent  Sheet quantities from 2,001 - Medium * [ veto |}

85 (= 95
T T e e T B B A O
0 10 20 30 40 50 60 [} 80 90 100
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6 Ganging Based on Cost or Rating

6.2.3 "Back Use" - respects the back side

The "Area Use" looks only for the front sheet. Additionally, we can respect the back sheet too:

- When a sheet has only jobs on front (back is empty) the back use is also 100%
- The function tries to create 4/0 and 4/4 sheets
- The slider definition defines the rating report result

80% of the front side and 50% of the back side must be filled.

5 Sheet Optimization Setup Editar: MSO - m} *

p: | MyMSO

Rating Criteria

Area Use

Areausein percent Medium w* [ veto W

a0 ) — 90
T T T T T T Y Y A A O I
] 10 20 30 40 50 60 70 80 90 100

Volume Use

1

e in percent Medium w [ veto i

1] 70 3
T T T T T T T T T T T A I S A I R A I B AR I
a 10 20 30 40 50 60 70 a0 a0 100

Note: The "Ganging Optimization Filter" allows to avoid empty back side jobs too!

"ﬁ Ganging Optimization Filker Editor unnarmed - [m] x

y Printing Material Quality [ Filter b

Caolors Front
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6 Ganging Based on Cost or Rating

6.2.4 "Date" - looks for the target date

Instead of "Date spreading” (Prinect 2020.0) we have now the criteria "Date".

We can define the "Date" criteria without a "Period" - earliest target dates are ganged first.

1l Sheet Optimization Setup Editar: S0 - O >

o MyMSO

I |MS0

Date in percent Earliest target date Medium * [ ve

50 - L
T T T T T T T T T O A I A R OO
0 10 20 30 40 50 &0 70 80 a0 100

Multiple Tups

With "Period": Looks primary to the defined next days (due date or print date is the target date).

The "Gang Server" generates gang sheets with the oldest target dates first, the last gang sheets are
generated up to the next 2 days of the target date.

6  OK Cancel

Date in percent  Earliesttarget date plus 2 days 4 - Medium > [] veto

50 2 L m—— @ 70 3
R N
] 10 20 30 40 50 60 70 &0 90 100

Multiple 1ups

Note: This criterion can only exist once.
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6.2.5 "Multiple 1ups" - tries to avoid multiple 1 up sheets

Many different jobs on one sheet => higher print quantities => less manual sorting.

We can define different ranges for the delivery quantity to gang sheets with single one Ups only.

Date
Multiple 1ups 1 .

) Edit Delivery Quantities >

1

Minimum Delivery Quantity |1

Jobs with a delivery quantity up to 500 must be ganged as single one Ups:

Multiple Tups

Multiple 1ups in percent  Delivery quantities to 500 { Medium

00 1
(ST e 6 1T 1 7 0 O O 2 R

0 10 20 30 40 50 60 70 80 a0 100

Between a delivery quantity 501 and higher we allow to generate multiple one Ups...

Date +

Multiple 1ups 1 -

Multiple 1ups in percent  Delivery guantities to 500 Cof Medium w [ veto |}

100 @ 100
T T A I A A I
0 10 20 30 40 50 60 70 80 90 100

l'}_H] Edit Delivery Quantities >

«1 501

500w

Minimum Delivery Quantity

Maximum Delive anti
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6 Ganging Based on Cost or Rating

... up to 30%. How many multiple of one job depends on job size, job amount, sheet size.

Date
Multiple 1ups

Multiple 1ups in percent  Deliy uantities 00 Medium ¥ [ veto i}

100 2 100

T I B A N
30 40 50 60 70 80 90 100

Multiple 1ups ent D uantitie 50 # | Medium v [ veto | W
70 ® 70

L T T T O O O Y A R A A O
] 10 20 30 40 50 &0 70 80 a0 100

6.3 "Ratings" in the "Gang Report"

The rating criteria slider define the status icon in the report.

We can define 3 different status: Red - Yellow - Green...

i3 Sheet Optimization Setup Editor: XL106-8P5-100

Name of Sheet Optimization Setup
Group
MName: |XL106-8P5-100

General Geometry Cost

Delete Pre t with Red Rating
Rating Critel

Area Use
Medium * [ veto
® 8 o 2

O O O 0 0 AT A A
0 10 20 30 40 50 60 70 80 90 100

1 percent Medium % [ Veto | [

& T 2

0 10 20 30 40 50 60 70 80 90 100

Volume Use
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The "Gang Report" displays the rating status:

Sheets IRating lQuantity Allowancs |Area Use Volume Use  |Multiple 1ups
Delivery quantities to 50,000
1| 9045% | 12000 0 |4 8649% |4\ 8487 % o 100.0%
2 | 8588% | 12000 0 | 9182% | 9021% A\ 7562 %
314 7498% | 17000 0 | 8032% |M 6548 % A\ 7916 %
41 o 868°% | 50000 0 |& sg85% M 7055 % of 100.0 %

A red rating would not create a gang job with the Gang Server when the option is enabled!

Sheet Optimization Setup Editor: XL106-8P5-100

Name of Sheet Optimization Setu|

General

Delete Pre
KAy Lrierna

1eet with Red Rating

A full gang report with 4 gang sheets and different ratings

- 3 ratings were active for the MSO parameter

« The column "Rating" is a weighted average for all rating criteria

Job Number: AutoOptimizeGangpool 05.12.19 15:04

Total Values:

Total Real Costs:
Total 8heet Count:
Efficiency Factor:
Number of Press Sheets:
Number of Placed Single Jobs:
Splits:

Deadline:

Total Target Quantity:

Total Allowance:

Total Paid Qverproduction:
Blank Waste (Sheets):
Printed Waste (Sheets):
Printed Waste (ltems):
Plate Template:
Paper Size:

Name of Optimizati

X106

13100.00
91000
74.08 %
4

21

0
859800
0

4200
11023
12562
80000

- Standard
3004 .72 pt x 2125 98 pt
Igorithm: 0_MSOCruncherSubAmount_Clustenng

\Allowance iArea Use

Sheets Rating Quantity Volume Use Multiple fups
Delivery quantities to 50,00
1 |of 9045% | 12000 04 0649% |4 8487% o 1000%
2 |of 85.88% | 12000 0| 9182% |« 090.21% 4 7562 %
3 |4 7498% | 17000 0|4 8032% |M 6548% 4\ 7916 %
4| o 858% | 50000 0|4 8985% ¥ 7055% o 100.0 %
No. [State \Job Target Date Delivery Quantity |Allowance [Overproduction Waste |Sheets
12|34
1w 12-019777 | CutMarksTest Dec 30, 2011 12:00 AM 50000 0 0 0 1
2 |of  [12-01876547 / Test-Nutzenkennungen  |Dec 30, 2011 12:00 AM 50000 0 1000 0 3
3 & |12-01876547 / Test-Nutzenkennungen  [Dec 30, 2011 12:00 AM 50000 0 1000 0 3
4 |of  [12-01878547 / Test-Nutzenkennungen  [Dec 30, 2011 12:00 AM 50000 0 0 0 1
5 f 12-01876547 / Test-Nutzenkennungen  |Dec 30, 2011 12:00 AM 50000 0 0 0 1
R ludf 12_.NARTARRAT | Tact Midzankanniinnan Meas A0 2044 12-N0 AR LEnnnn n n n 1
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6 Ganging Based on Cost or Rating

6.4 "Priority"

If you have more than one setting active you can set up here the order for the most important setting:
+ Very high
+ High
+ Medium
« Low
» Very low

All active ratings are combined to a weighted average!
It might happen that a sheet is rated OK, even if your parameter with the highest priority is red.
Example 1

+ Very high: Sheet with 90% for Area Use => green
+ Low: 60% for Back Use => red

=> The final report will display green!
Example 2
+ Very high: Sheet with 71% for Area Use => green

+ Low: 10% for Back Use => red
=> The final report will display red!

] Sheet Optirnization Setup Editor: MS0 - O x

Group: | MyMSQ

MName: |MSO

Rating Critel

Area lse

Area use in percent Wery high ¥ "] veto

70 e 70

T T T I T A I A I A B
0 10 20 30 40 50 60 70 80 90 100

Volume Use
Back Use

Back use in percent

70 Wery high
— e High
[ | [ | [ [ | [ [ [ | [ (| |
| | ! | | | _| | RS L
0 10 20 40 50 50 70 80

Very low
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6.5 "Veto"

A "Veto" can overrule all other rating criteria

- The "Veto" flag will be respected as a last step after rating calculation.
- it can make the rating result worse
« but it cannot make a rating result better

Examples 1
- The weighted average about all ratings would generate a 'green’ rating,
but the "Area Use" in "Veto" has only 69% => the press sheet would be deleted
Examples 2

- The weighted average about all ratings would generate a 'red’ rating,
but the "Area Use" in "Veto" has only 71% => the press sheet would be deleted

5 Sheet Optimization Setup Editar: hSO - m} x

p: | MyMSO

©MSO

Area use in percent Medium - Weto

=] 70
L T e e T O A A
0 10 20 30 40 50 &0 70 80 a0 100

Volume Use

Back Use

Back use in percent Medium » [ veto

30 ® 30
L e e o A
] 10 20 30 40 50 60 70 80 ag 100

inpercent  Earliesttarget date plus /S Medium - [ veto

2 80
T T e T O O Y R A I I |
0 10 20 30 40 50 60 70 80 a0 100

Multiple 1ups
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7 Ganging Optimization

7 Ganging Optimization

7.1 MSO Parameter — "Placement”

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

Customers wants to define the placement direction to get better cutting results.
Description

The "Placement" parameters has been added for:

« Sheet Optimization without Layout Default
« Sheet Optimization with Segments

"Primary placement direction" (has moved from the "General" tab into the "Placement" tab)

- Generally: - the gang jobs can be placed horizontal or vertical, the best result will be used
+ Horizontal - the gang jobs will be placed horizontal
« Vertical - the gang jobs will be placed vertically

"Placement starts horizontally”
. Left

- Right

"Placement starts vertically”

+ Bottom
- Top
"Placement” in "MSO Parameter: Sheet Optimization Setup”.

5 Sheet Optimization Setup Editar: kSO — m} x

Ny
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7 Ganging Optimization

7.2 MSO Parameter — "Sheet Brake" and "Horizontal Lanes"

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

Customers want to define the sheet brake width to define unprinted paper areas.
Description

The optimization parameters are extended by:

- Width of the sheet brakes - vertical clearance areas
« Number and width of the horizontal lanes - for "Ganging with Segments" only
) sheet Optirnization Setup >

Placement Cost Rating

Left Margin: 8.0 Right Margin: | 8.0

Bottorm Margin: 156.0 Top Margin:

1up Block Margin:

Total: 3 Width: | 8.0
| Lanes Total: | O Height:

Cancel

The sheet break width is excluded for ganging.

12-05-20-1_GangSermver/ Product Part: GangForm-XL106-2-300 Graphics X

Assel 1up List Press Sheet List Document
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7.3 MSO Parameter — Sorting of Press Sheets

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

After the "Multi Sheet Optimization" the generated print sheets should be sorted in a controlled order.
Description

The following sort criteria run one after the other:

n

- Keep identical layouts together - "Sheet Optimization for Packaging" and "Ganging with Layout
- Sort by due date - the oldest date per sheet first

- Sort by run length - long run sheets first

7.4 MSO Parameter — Alignment of Job Internal Resources

Motivation

The alignment of job internal resources has been extended by the resource type "Sheet Optimization
Parameter”.

Description

When loading a saved job, the internal resource "Sheet Optimization Parameter” is now compared
with those in the resource area in addition to the plate template because it can be edited within a job.

When a change is detected, we are asked whether the version from the resource pool should be used.

% Prinect Signa Station Server: Question X

? 21097:  Internal optimization parameter check!

Explanation:

The optimization parameter “MSC" is different to that in the resource pool.
Do you want to use the version of the resource pool?

D Do not show this window again.
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7.5 Editing of Incoming Gang Jobs

. Note: This feature was implemented in Signa Station 2020.10.
2020.10

Motivation

The editing of individual orders in the input list for sheet optimization should be easier.
Description

Single jobs in the input list for sheet optimization can be edited using the context menu:

+ Until Prinect 2020: Only the entries 'Enable Gang Part from Gang Job', 'Disable Gang Part from
Gang Job' and 'Remove Gang Part from Gang Job' was visible in the context menu.
For all other entries the cursor had to be in the corresponding column of the table.

» Now: All entries available for this mode are displayed in the context menu — regardless of the
column in which the quote is displayed.

= ¢ / == - 5
L] \ Y & =
Mew Job Product Part Optimization EE Contents Press Sheet

GangForm-XL106-2-300 -- Sheet Optimization without Layout Default Optimization 12-05-20-1_GangSernver/ Product Part: G...  Graphics X

Input List tor Sheet Optimization Press Sheet List Document

- Assembly Block 1up List
ke »

600 1000
sl b sl b

= + | Joh + | Article +  Customer

-
-

-\/
1

00
M20-00010/ G ol

)
il

Ganging... Import PDF...

¥ Geometry Data for Sheet Optimization
Let & 0

¥ Cost Data for Sheet Optimization
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8 Ganging with Segments

8 Ganging with Segments for Finishing

. Note: We only enable this feature for customers, when a chargeable project has been
1 started. You can contact the Prinect Product Management for further informations.

Motivation
For a printer with a Web2Print shop we have developed "Ganging with Segments for Finishing":

+ Keep jobs with the same finishing procedure together in segments on the press sheet

- Create from a large format press (XL162, XL145) small cut blocks for finishing devices

e

[ (] (0 [ [y

Description
The segment workflow is based on "Product Codes", defined from a web shop:

- Example of a Product Code: F-F4-1_VAR_S-A4_C4x4_135Glossy
- Translation of the Example: FoldingScheme_Varnishing_Format_Color_PapierQuality

When this license is enabled...

l'?:'] Preferences

General Paths Names Defaults Resources Reports JDF Import
Import Processes Output Ganging Optimization User Interface Packaging

Options:
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... the "Segment Templates" are displayed in Signa Station Resources.

File | Edit | Jobs&Re: es | Inspectors | Tools | Help

Machines
p-C1 Job Templates
»- 1 Product Part Templates:

Segment Templates

B0 Varni

»-C1 plate Templates
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9 Java AdoptOpenJDK 11

Motivation
Oracle Java 11 is not longer free of charge.
We should change to Java AdoptOpenJDK 11 to avoid higher prices for Heidelberg and our customers.
Description
In Prinect 2021 we have implemented Java AdoptOpenJDK 11 for:
- Signa Station

+ Cockpit
- DataTerminal

In the application property file we can see the Java path and that Oracle Java (sun) is deactivated.

l;]" CAPrograrm Files\Heidelberg'Prinect Signa Station 1\PrinectSignaStationdTprop - Notepad + + [Administrator]
File Edit Search View Encoding Language Settings Tools Macro Bun Plugins  Window 7

= L, > = ! == = -

g B ooIlEfll E‘_I| |ﬂﬂ£;&|‘§ >|—'.—.| # EEEAE |E| (]
[ PrinectSignaStation21. prop E3 l

1 #wir

2

3 startolass = gomw, heidelberg.sigha.main. Signalain

“

5 [javadllpath = ./JRE/bin/server/jvm.dll ]

& Jdirersion = 1.5 1.4.T1.%

7 startonce = true

=1

=) sun. javaZzd.noddrawv=false

10
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Heidelberger Druckmaschinen AG
Gutenbergring

69168 Wiesloch

Germany

Phone +49 6221 92-00

Fax +49 6221 92-6999
heidelberg.com

Copyright © 2020 Heidelberger Druckmaschinen AG.
No part of this book may be reproduced without prior written permission.

Important Notice:

We are dedicated to improving and enhancing our products. Consequently,
the information in this manual is subject to technical modifications and
other changes without notice. Heidelberger Druckmaschinen AG assumes
no responsibility for information and description as far as third-party
products are concerned.

The information contained in this manual about performance and speed
as well as technical data concerning application of our products is not
legally binding as it does not constitute a written contract of features. If
any problems occur with the product described in this manual, please
contact the Heidelberg agency which is responsible for you.

Revision 1.0

Version 2021

The software used during the training is just for training purposes. You are
not supposed to forward this software to the customer. The software for
the customer has to be downloaded on the official way.

Impressum
Fonts: Heidelberg Antiqua ML, Heidelberg Gothic Ml

Trademarks

Heidelberg, the Heidelberg logotype, Prinect, Suprasetter and
Speedmaster are registered trademarks of Heidelberger Druckmaschinen
AG in the United States and other countries.

Adobe and PostScript and Acrobat are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or
other countries.

PANTONE and Hexachrome are registered trademarks of Pantone Inc.
All other trademarks are property of their respective owners.

Subject to technical modifications and other changes.
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